
Windows 7 Files & Folders 

File:  A collection of digital data or information that has a name, called the filename. 
Almost all information stored in a computer must be in a file. There are many 
different types of files: numeric data , text, image,  sound, video, executable 
programs , directory , and so on. Different types of files store different types of 
information. For example, program files store programs, whereas text files 
store text. 

 

Filename:  A human-readable label identifying a file.  The part of the filename after 
the dot, called the filename extension, identifies the filetype.  When you “open” a 
file, the operating system (Windows) uses the filetype to decide which program to 
use to handle that file.  Example:  A filename extension of .docx tells Windows to 
open the file with the MS Word program. 

 

Folder: In graphical user interfaces such as Windows and the Macintosh environment, 
a folder is an object that can contain multiple files. Folders are used to organize 
information.  In the DOS and UNIX worlds, folders are called directories. 
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Windows 7 Libraries 

 

A Library gathers files from different locations and displays them as a single collection, 
without moving them from where they are stored. 

 

Here are some things you can do with libraries: 
• Create a new library. There are four default libraries (Documents, Music, Pictures, 

and Videos), but you can create new libraries for other collections.  
• Arrange items by folder, date, and other properties. Items in a library can be 

arranged in different ways using the Arrange by menu, located in the library pane 
(above the file list) in any open library. For example, you can arrange your Music 
library by Artist to quickly find a song by a particular artist. 

• Include or remove a folder. Libraries gather content from included folders, or 
library locations. For more information, see Include folders in a library. 

• Change the default save location. The default save location determines where an 
item is stored when it's copied, moved, or saved to the library.  

 

We will look at Windows Explorer together to see that everything showing in the 
Libraries folder when you first use the PC – Documents, Music, Pictures, and Videos 
– appears again farther down in the left pane.  For example:  My Documents is 
under Libraries;  the same My Documents is also under the folder named with your 
logon name;  and it is under OS (C:)/Users/<your name>/ yet again. 
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Windows 7 Logon Users & Permissions 

 

 

Logon User:  A user is nothing more than a name representing a collection of 
permissions to see, read, and write to files and folders,  plus a collection of settings 
that control how Windows behaves when that user is logged on.  User permissions are 
managed by an Administrator.  On your home PC, that is probably you. 
 
Permissions:  Each file, folder, and function of Windows has a set of properties.  
Among those properties are permissions for each user – permissions to read, modify, 
and execute.  If a particular logon user – say, for example “Guest” – has been assigned 
no rights to a file or folder, then when that user is logged on she will simply not be 
able to see, much less act on, that file/folder.  That is how a PC’s hard drive can hold 
email and other personal information for multiple users, each of whom is blind to the 
others’ information. 
 
User Profiles:  Each user also has a “profile” of configuration settings, some of which 
the user can himself manage;  other settings are managed by the Administrator.  
(More on this later when we explore the Control Panel.) 
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Why is the 1st Fixed Disk (Hard Drive) called C:? 

The original PCs had NO fixed disks -- at first tape 
drives in the ‘70s, then later replaceable “floppy” 
disks.  In the DOS operating system they were 
named with letters … A:, B:, etc.  
  
When fixed hard disk drives showed up in the early 
‘80s,  conventional wisdom said that two floppies 
were enough,  so everyone settled on C: as the 1st 
fixed disk,  and the one that would contain “boot” 
information.   
 
Most new PCs don’t even have floppy drives, so 
letters A: and B: are almost forgotten. 
D: is often a PC’s DVD drive, and E: is often a USB 
Flash drive. 
 
On your home PC, other “mapped network drives” 
such as U: and W: probably don’t exist.   Looking at 
Start > Computer at home, you will see something 
like the image at left.  (Note that my Task Bar in 
this screenshot is placed at the right, not the 
bottom – my preference, and your choice.) 
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Parts of a Windows Explorer Window 

Menu Bar 

Close 

Maximize 

Minimize Back/Forward Buttons  

Status Bar Border 

Location/Address Refresh 

Command Bar 

Navigation Pane 

Content Pane 

Preview Pane 
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Note:  This screenshot is from my home PC, NOT from BMC 207 lab. 
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Windows Explorer Menu Bar  
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NOT Visible 

Visible 

Menu Bar 

Note:  This screenshot is from my home PC, NOT from BMC 207 lab. 
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Windows Explorer Filename Extensions  
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Filename Extension 
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Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Three views of the same sub-folder in Windows Explorer 
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Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Windows Explorer Menu Bar Menus (File & Edit) 
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= Left Click 

Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Windows Explorer Menu Bar Menus (View, Tools & Help) 
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= Left Click 

Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Windows Explorer Toolbar Menus (Organize & Share) 
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= Left Click 

Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Windows Explorer Context Menus (Title Bar & Toolbar) 
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= Right Click 

Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Windows Explorer Context Menus (Navigation & Content Panes) 
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= Right Click 

Note:  This screenshot is from my home PC, NOT from a lab PC. 
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Windows Explorer 
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New-Folder -- 1st Exercise 
Create a new folder, and another new folder inside of it. 

1. Open Windows Explorer by clicking the          icon on the toolbar. 
2. Find the U: drive in the left Navigation pane.  (U: is your personal area on the MPC 

network server) 
3. Notice that if you have just opened Windows Explorer, a small   image will 

appear at the left ONLY when your mouse pointer moves over the U: line. 
4. Click  the .  Later you will see some folders underneath the U: line,  but no 

change in the content pane. 
5. Click the U: line.   If there is anything in U:  it will appear in the Content pane. 

(You could also have Double-Clicked the U: line,  or Right-Clicked and selected 
Expand from the context menu.)   

6. Right-Click the U: line and select New  Folder.  Notice the words New Folder 
7.  highlited.  Without clicking or moving the mouse, use the keyboard to type your 

last name in the box and press Enter.   Result:   
8. Now again,  Right-Click that folder line you just created, select New  Folder, and 

name this sub-folder with your first name, then press Enter.  
The shorthand an experienced user might understand for this exercise would be … 
 create a new folder U:\{yourlastname} and a sub-folder in it ..\\{yourfirstname}\. 

That’s it for your first for-credit exercise.  I’ll be able to see your new folders later. 
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Windows Explorer 
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Copy-&-Paste-Files -- 2nd Exercise 
Try out the four methods to copy/paste files. 

1. Open Windows Explorer again if it’s not open already. 
2. Find the U: and W: drives in the left Navigation pane.    
3. Double-Click on each line, so that sub-folders under them are visible in the 

navigation pane.  Drive U: should have folders you created in the 1st exercise. 
4. In the W: drive,  find the folder 71a, and under it a folder named w2u-exercise.  

Inside that folder find a file in the Content Pane named w2u-1.txt. 
5. With that file highlighted, Right-Click and select Copy from the context menu. 
6. Highlight the sub-folder on U:  that you created with your first name. 
7. With that sub-folder on U: highlighted,  Right-Click and select Paste. 
8. Now try to do the same task with the other files in W:\w2u-exercise\ using the 

other three methods of doing the exact same thing … 
a. Ctrl-C / Ctrl-V  
b. Drag-and-drop 
c. Main Menu Edit > Copy and Edit > Paste. 

The shorthand an experienced user might understand for this exercise would be … 
 copy the fourfiles in W:\w2u-exercise\ to U:\{yourlastname}\{yourfirstname}\ 

 using four methods … 1. context menu 2. Ctrl-C/V 3. drag/drop 4. edit menu 

That’s it for your second for-credit exercise.  I’ll be able to see what you did later. 
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Windows Explorer 
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Change sort order, copy and rename – 3rd Exercise 
 

1. Open Windows Explorer again if it’s not open already. 
2. Find the U: and W: drives in the left Navigation pane.    
3. Find the folder on W: named \img. 
4. Click the Date modified column header to show a down arrow (), indicating sort 

order newest-to-oldest. 
5. Copy the newest file in W:\img\ and paste it into a new folder you create on U: 

named u:\img\newest\. 
6. Re-name the file you just copied into u:\img\newest\, calling it newestfile leaving 

the .png filename extension unchanged. 
7. Navigate back to W:\img\.  Click the Date modified column header to show an up 

arrow () , indicating sort order oldest-to-newest. 
8. Copy the oldest file in W:\img\ and paste it into a new folder you create on U: 

named u:\img\oldest\. 
9. Re-name the file you just copied into u:\img\oldest\, calling it oldestfile leaving the 

.png filename extension unchanged. 
The shorthand an experienced user might understand for this exercise would be … 
 copy and rename the newest file in w:\img\ to u:\img\newest\newestfile.*,   

 copy and rename the oldest file in w:\img\ to u:\img\oldest\oldestfile.*. 

That’s it for your 4th for-credit exercise.  I’ll be able to see what you did later. 
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Windows Explorer 
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Un-hide Extensions / File Type Filtering – 5th Exercise 
1. Open Windows Explorer again if it’s not open already. 
2. Find the U: and W: drives in the left Navigation pane.    
3. Find and click the folder on W: named \img. 
4. Use one of these two methods to un-hide the filename extensions in \img\: 

• Tools > Folder options > View >  Hide extensions for known file types 
• Organize > Folder and search options > View >  Hide extensions … 
Then click the Apply button, then Ok. 

5. With the mouse pointer over the Type column heading, notice and click the  
symbol to the right, and select PNG File.  This filters out all but the .png files. 

6. Click the Content Pane, Press Ctrl-A to select all 
the .png files in W:\img\  and copy/paste them 
into a new folder  you create … u:\img\png\. 

7. Navigate back to W:\img\.  With the pointer over  
the Type column heading, notice and click the  symbol to the right, un-select 
PNG and select JPG. 

8. Copy all the .jpg files in W:\img\ and paste into a new folder you create u:\img\jpg.  
The shorthand an experienced user might understand for this exercise would be … 
 copy all the .png files in w:\img\ to new folder u:\img\png\;   

 copy all the .jpg files in w:\img\ to new folder u:\img\jpg\. 
That’s it for your 5th for-credit exercise.  I’ll be able to see what you did later. 
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Windows Explorer 
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Multiple-File Selection – 6th Exercise 
 

1. Open Windows Explorer again if it’s not open already. 
2. Find the U:  drive in the left Navigation pane.    
3. Find and click the folder u:\img\jpg\. 
4. In the Name column header , use the 

filter drop-down  tool (shown at right) to  
select 0-9.  You  should see about four files  
whose names begin with digits.   
(Notice that the filter drop-down tool is context-sensitive. It no longer shows file Types, but 
instead shows filename-specific choices.)   Click on the Content pane to dismiss the filter box. 

5. Press Ctrl-A to select all visible files,  then press the Delete key and click Yes when asked “Are 
you sure ..”.  Gone.  Use the Name filter again -- noticing that the 0-9 choice has disappeared – 
to choose another filter,  say A-H.   Finally, un-check the A-H filter. 

6. You should see all files, MINUS those with digit filenames, because those were just deleted. 
7. Find and click the folder u:\img\png\.  Click-select  the top file,  then while holding down the 

Shift key, click-select the fifth file.   Now you have five files selected.  Press Ctrl-X to Cut them.  
(They will be held in the “clipboard”,  but if you don’t paste before doing another copy, they 
will be unchanged.)    Don’t Paste for now.  Instead … 

8. Last step:  Click-select the top  file.   This time, holding down the Ctrl key,  click  every other 
file until you have  five selected.  In the File menu, select Delete and click Yes when asked “Are 
you sure ..”. 
 

That’s it for your 6th for-credit exercise.  I’ll be able to see what you did later. 
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Next up .. Browsing the Internet 
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